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Executive Summary

» Write a program that will interact with the free
Windows game Minesweeper
- Take control of user’s cursor
- Take control of user’s clicking actions

» Read data directly from Minesweeper window

» Integrate code containing the logic to automatically
play through and beat a game of Minesweeper

» Write game log and user statistics files

Purpose

» Create a tool that is helpful and fun to all users
> Provide unique options not found in Minesweeper
> Engaging to both inexperienced and experienced players

» Broaden my programming experience
> Interacting with an opened application
> Integrating another’s code into my program
- Artificial intelligence

» Gain more experience using object oriented
programming
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What is Minesweeper?

System Analysis
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Minesweeper Interaction Program

» Interfaces with Windows 7 version of Minesweeper
> Playable entirely through program

» Reads and interprets game data based on tile colors
> 16 different game colors in total
- Different red, green, and blue combinations

» Stores game data in a 2-dimensional array
> 9 x 9tile grid, 16 x 16 grid, or 16 x 30 tile grid

» Graphically displays game board

» Automatically changes game options

Minesweeper Interaction Program

» Creates Game Log output file
o Start date/start time
- Each move made

Won or lost

Difficulty level

Final game board

o o o

» Creates Statistics output file
> Games played
> Games won
- Games lost
Win percentage
Longest winning/losing streaks
Average guesses per game

o o o
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System Architecture

Minesweeper Game Window
& Mineswesper (= ]

Game  Help

User Interface through
Command Prompt Window
B Cotwindowdsyetams Eigrrd e L B i
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Game LuiFilE \A U ser Statistics File
Game #: ‘Games Played:
Diate/Time: Games Won:
Games Lost
Game History: Win Percentage:
Cell (1,1} / Reveal Tile
Cell (5,3) / FlagTile Longest Winning Streak:
Cell (2,4) / RevealTile Longest Losing Streak:
Aversge Guesses Per Game:
Won/Llost
9
Magenta
In computers, each color is assigned an intensity level from 0 to 255
10
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System Design

Development Tools
» Microsoft Visual Studio 2010 IDE

» C++ Programming language

» Microsoft Visio 2010
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Key Components

» Window Handler (HWND) Object allows:

> Data retrieval from window
> Manipulation of window’s size, position, or appearance

» Window Size Detection
- Size of window changes as difficulty level changes
> Boundaries of game must be known
- Retrieve dimensions with GetWindowRect() function

Difficulty Window
Level Width
Beginner 223 pixels
Intermediate | 349 pixels
Advanced | 601 pixels

Key Components

» Resizing Game Window
> Program only works when window size is smallest
> ShowWindow() function restores window to its original size
and position
> SetWindowPos() function shrinks window

» Changing Game Options
> When problems are encountered, options are changed
> Uses function keys (F5, F7) and hot keys to navigate menus
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Key Components

» Simulating Key Presses
> keybd_event() function

» Simulating Mouse Movement
> SetCursorPos() function
> Given x and y pixel coordinates

» Simulating Mouse Clicks
> SendInput() function

P w

Key Components

» Color Detection
> First, find location of game grid

-
& Minesweeper @ﬂu

Game Help
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Key Components

» Color Detection (continued)
- Read one pixel from each tile using GetPixel() function

= (2]73]

- Retrieve red, green, and blue values from COLORREF object

Key Components

» Color Interpretation
o Interpret red, green, and blue intensity values

> 16 different tile types in total

> All 16 contain different range of color values
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Lightness/Darkness of Game Window

Intermediate
Values

Darkest and
Lightest Values
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Tile Types and their Color Values (for version 1)

Tile Red Blue Green Additional
Tile Type .
Appearance | Values | Values | Values Constraints
Empty 147-219 148-222 200-254 green - red > 20
Number 1 1 63-116 155-189 80-144 none
Number 2 2 40-92 15-84 106-136 red > blue
Number 3 3 143-173 8-64 8-84 none
Number 4 4 11-125 125-154 14-162 none
Number 5 5 115-127 4-45 5-64 none
Number 6 6 23-125 129-148 133-188 none
Number 7 7 Unknown | Unknown | Unknown none
Number 8 8 Unknown | Unknown | Unknown none

20
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Tile Types and their Color Values (for version 1)

s’ blue + 3 2 red AND
'l - - :
Green Unopened 48-115 45-140 112-215 red + blue - 40 5 green
Green Unopened 80-147 | 112-203 | 176-255
(highlighted) nene
Blue Unopened 48-162 179-253 65-216 none
Blue Unopened
(highlighted) ! 80-194 242-255 129-255 none
Flag 7 i 160-238 | 164-239 | 165-240 green - red =20
Flag (highlighted) ﬂ 191-247 244-252 | 225-252 none
Mine . 50-180 50-170 70-170 none

21

Key Components

» Different versions of Minesweeper
> Three known versions of Minesweeper
> Each displays colors differently

» Different versions of my program
> Two versions of the Minesweeper Interaction Program
> Two sets of color interpretation rules
- Often detects if wrong version is being used

22
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Coordinate System

€& Minesweeper Elﬂlg
Game Help
Column #
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Each tile's coordinate can be referred to by a function
of its row number and column number.
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UML Class Diagrams

24
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Class Relationships

Gamelog

Manages
—D

Minesweeper

Statistics

Manages

25

Minesweeper Class (attributes)

Minesweeper

-individualTileWidth : int
-individualTileHeight : int
-pagelnsertWidth : int
-pagelnsertHeight : int
-rowTilesTotal : int
-columnTilesTotal : int
-minesRemaining : int
-playMode : int

-playSpeed : int

-guesseshade : int
-safeMoveFound : bool
-doGamelogOutput : bool
-doStatisticsOutput : bool
-possibleinfiniteLoop : int
-gameGrid[][] : int
-gamelogObject : Gamelog object
-gamelogFileName : string
-statObject : Statistics object
-statisticsFileName : string

-hdc : HDC object
-minesweeperHwnd : HWND object
-minesweeperChildHwnd : HWND object
-gamelostHwnd : HWND object
-gameWonHwnd : HWND object
-consoleHwnd : HWND object
-consoleTitle[] : TCHAR object
-applicationName : LPTSTR object

26
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Minesweeper Class (functions)

[+Minesweeperinteraction()

+~Minesweeperinteraction|)

+AutomaticPlaythrough{) : int

+UserPlaythrough()

[+GameGridChecker()

+GameGridDisplay()

+ChangeDifficulty()

+ChangePlaySpeed(in givenPlaySpeed : int}

+StartNewGamel)

+Help()

+CreateGameLlogFile() : bool

+CreateStatisticsFile() : bool

+CloseMinesweeper()

+OpenMinesweeper()

[+SelectProperOptions()

[+UpdateCurrentGameDimensions()

+UpdateTotalMinesRemainingl)

+SetPlayMode(in playingModelnput ; int)

+SetSafeMoveFound(in safeMoveFoundinput ; bool)

+GetSafeMoveFound() : bool

+AdvancedAnalysis()

+AdvancedAnalysis2(in rowOfRelatedTile : int, in columnOfRelatedTile : int, in rowOffLimits - int,
in columnOffLimits : int, in rowOffLimits2 : int, in columnOffLimits2 ; int) : bool
-MoveMouseClick(in rowNumber : int, in columnNumber : int, in whichClick : int)
-LeftClick{)

-RightClick()

-LeftPlusRightClick()

-TileDetection(in rowNumber : int, in columnMNumber :int) ; int
-Calorlnterpretation{in r zint, in b : int, in g :int) : int

-DetectGameOver() : bool

-SafeMove(in safeRowNumber ; int, in safeColumnNumber : int, in whichClick ; int)
-FindMinesweeperWindow()
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Gamelog Class

Gamelog

~currentGameNusmber ; int
-outFileName ; string
-writeGamelogFile : fstream chject

+HEamelogFile()

+*GamelogFile()

+EetutputFileMame{in outputFileMame : string) = hoal
+PrintHeadinglnformation()

+PrintGameHistorylin xPosition : int, in yPosition : int, in whichClick : int)
+PrintFinalGameBoard|in visualToPrint ; string)
+PrintGameCompletedinformation{in winLose : string, in difficultyLevel : string)

28
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Statistics Class

Statistics

-outFileMame : string
-writeStatisticsFile : fstream object
-gamesWonBeginner @ int
-gamesWonlntermediate : int
-gamesWonAdvanced : int
-gameslostBeginner @ int
-gameslostintermediate : int
-gameslostAdvanced : int
-gamesPlayedBeginner : int
-gamesPlayedintermediate : int
-gamesPlayedAdvanced : int
-currentWinStreakBeginner : int
-currentWinStreakintermediate :int
-currentWinStreakAdvanced :int
-currentLoseStreakBeginner :int
-currentLoseStreakintermediate : int
-currentLoseStreakAdvanced : int
-longestWinStreakBeginner : int
-longestWinStreakintermediate : int
-longest\WinStreakAdvanced : int
-longestLostStreakBeginner : int
-longestLoseStreakintermediate : int
-longestLoseStreakAdvanced : int
-guessesMadeBeginner : int
-guessesMadelntermediate : int
-guessesMadeAdvanced : int

+StatisticsFile()

+~StatisticsFile()

+SetOutputFileName(in outputFileMame : string) : bool

+UpdateGameCompletedinformation{in winLose : string, in difficultyLevel : string, in totalGuessesMade : int)

+PrintStatistics() 29
System Testing
» All threshold requirements met
» Five of seven objective requirements met
ID# | Requirement Inspect, | Pass/
Analyze, | Fail
Demo or
Test
The system shall assign a grid system to the active playing
A3 window that stores the status ofthe game window. Analyze | Pass
A6 The system should emulate an intelligent human playing the Inspect Pass
game.
A-7 | Thesystemshould not trigger any anti-virus warnings. Test Fail
) The system shall be able to accurately interpret the colors of at
B-1 least 13 out of 16 different tile types. Analyze | Pass
B2 The system shall be able to accurately navigatea user's cursor D P
~ | toevery tile on the game grid on the hardest difficulty. emo ass
The system shall be able to accurately left click on every tile
B-3 on the game grid on the hardest difficulty. Demo Pass
&@\\\ . ?
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ID# | Requirement Inspect, | Pass/
Analyze, | Fail
Demo or
Test
C-2 | The system shall maintain a file of the game log. Inspect Pass
C-3 | The system shall maintain a file of user statistics. Inspect | Pass
D-3 | Thesystem shall operate on the Windows 7 operating system. Test Pass
WV i r 71 i
D4 The system should operate on the Windows Vista operating Test Fail
system.
E-5 IThe systelrm shall read the colors of pixels to interpret the game Analyze | Pass
information.
E-6 | Thesystemshouldbe able to detect when a game has ended. Analyze | Pass
The system should be able to detect if a user either wins or
E-7 1 Analyze | Pass
0ses a game.
The system should be able to detect the dimensions of the
E-8 . . . Analyze Pass
active playing window.
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Cost Management

» Estimated labor hours: 90 hours
» Actual labor hours: 140 hours

» Total cost for materials for this project was $0

Task Estimated Hours | Actual Labor Hours
System Design 7 hours 8 hours
Detailed Design 42 hours 66 hours
Data Detection & Interpretation 15 hours 31 hours
User Statistics Storage & Output 12 hours 10 hours
Game Interaction 15 hours 25 hours
System Integration 15 hours 22 hours
Requirements Verification 6 hours 5 hours
Final Report Development 10 hours 30 hours
Presentation Development 10 hours 9 hours

32
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Risk Analysis

Risk Description

Rank

Response

End Result

Hard drive crashes.

MEDIM

Mitigate - | mitigated the severity
of this risk by frequently backing
up my program data on an
external hard drive.

Risk did not occur

UML diagram turns out to be
inaccurate.

MEDIUM

Avoid - | avoided this risk by
doing some of the development
of my program before Phase Il
began in order to get a better

idea of what the basic
architecture will look like.

Risk did not occur, but had | not
started development of the
program before Phase II, this risk
would certainly have occurred,
and | would have become behind
schedule.

There exist overlapping colors for
differenttile types, making it
difficult to interpret the game
information.

MEDIUM

Accept

Risk did occur, but | had to
accept it. While it added
additional labor hours to my
project, it did not put me behind
schedule.

Unexpected additions to project
scope due to technical
uncertainty.

HIGH

Mitigate - | mitigated the
likelihood of this risk by doing
some of the development of my
project before Phase Il began in
order to reduce any technical
uncertainty associated with the
project.

Risk did not occur, | believe it
was effectively mitigated before
Phase Il began.
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Conclusion
» Project was completed on schedule
» Project requirements all met
» Lessons Learned
> Programming techniques I've learned in school can be
applied to virtually any program
> Gained experience modifying and interpreting another
person’s code
> Programming computers to think like humans is remarkably
difficult
> Projects are unpredictable, a little bit of planning can go a
long way
34
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Demo

35
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